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Abstract 

In this advance era of technology, the application of integrating Augmented Reality has become 

more commonly used in education compare to last decade. This project is carried in terms of study 

whether implementing AR technology in education will solve or improve the problem of current 

situation faced by almost every student in any ages which is feeling loss of engagement towards 

study, do not have reading habits since youth, did not found fun while study and also the interaction 

between teacher and student.  

This project is a development of a proposed mobile application which in the field of integration of 

Augmented Reality technology with the physical storybook. The target audience of this application 

are children in early childhood education from aged 2 to 7 to cultivate their reading habits since 

youth. The scope of this proposed application is aim to increase the motivation, engagement and 

interaction of the target audience in a better and interesting learning environment compare with an 

ordinary storybook. Intergrading Augmented Reality in an ordinary storybook creates an 

immersive experience toward children and raise their interest in the content of storybook. Parental 

supervision is required while using the application, which also benefits the interaction between 

parents and also their children. Questionnaire are constructed and analysed to seek user’s opinion 

on the proposed mobile application where the proposed application is needed by the community 

and also analysing the reading habits of children. 

Agile Model of methodology are applied as the approach in order to develop this proposed system 

is this project. There are five phases included in Agile Model which is planning, requirement 

analysis, design, implementation and evaluation performing different task which helps to develop 

the project. Development tools such as Shotcut, Vuforia SDK, Visual Studio 2017, Blender and 

Unity 3D is used to develop the proposed mobile application. The appropriate computer language 

for developing this application will be C#. 
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Chapter 1: Introduction 

1.1 Problem Statement 

The problem statements of this project are shown as follow: 

1. Loss of engagement in learning. 

Children are naturally curious about new things and playful. Children learn when they play 

and explore new things. With the advancement in technology today, many entertainments out 

there are more interesting compared to learning in preschool such a traditional way with 

physical books and copy files provided by the teacher (Parhizkar et al. 2011). Other than that, 

several researchers found out that another limitation of the usual learning materials such as 

physical books that contains less interactive content which may cause the students got bored 

and exhausted about learning (Abadi et al., 2018). Hence, children have trouble with focus and 

concentration in studies. Some studies conducted by researcher also shown that an interactive 

learning environment could change a passive learner to an engaging active learner. Therefore, 

instead of providing traditional one-way communication learning materials, an integrated 

element of multimedia such as audio, animation and interactable mobile application can be an 

effective learning material for children. 

2. Loss of reading habits in youth 

Due to the mass media in the current world, not only children but also adults do not show much 

interest in reading books, magazines, journals and others (Palani, 2012). It is important to 

cultivate reading habits from the youth. The earlier a child starts to receive education, the faster 

the child could absorb more knowledge. Positive early reading experiences predict better 

reading and language developments and children who experienced rich verbal and affective 

interactions during shared book reading are more likely to enjoy and show interest in reading 

later in childhood.  
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3. Lack of interaction in traditional classroom. 

Traditional teaching method often uses teacher-centred which only providing one-way 

communication. This is hard to ensure a student can absorb the knowledge effectively. Teacher-

centred traditional classroom aims to impart knowledge to students, in which teacher performs as 

the main role in the classroom, and students will focus and listen on something that the teacher is 

taught to the student, write down some information or notes about what they are receiving, think 

something independently what they are listening (Li et al, 2014). So, the lack of interaction 

between students and teachers resulting in students often behaves passive behaviours. Studies 

conducted by researchers found out that the traditional teaching method is failing in knowledge 

transfer and its transfer power from teacher to student (Fahiminezhad et al., 2012). 

4. Lack of enjoyment during studies. 

Lack of enjoyment during studies is a crucial problem faced in the education field from past to 

present and it was a factor examined in this study. Researchers stated that enjoyment is closely 

related to learning, motivation, and interest in the learning material that can be improved (Yilmaz, 

Kucuk & Goktas, 2017). Attractive elements in computer technology applying in the form of 

education could be helpful in learning. (Wang, He and Dou, 2013) found out that students have 

positive attitudes towards AR applications, in the student perspective of view, AR is easier to use 

and more inspirational compare to traditional learning activities. 
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1.1.2 Motivation  

The motivation to develop this project is to improve the problems stated in section 1.1 and also 

encourage children to cultivate reading since youth. Other than that, the author wishes to provide 

the students to have an interactive and interesting reading experience. Instead of learning in the 

traditional method such as reading from an ordinary storybook, an interactive augmented reality 

storybook that consists of text, image, audio, and animation is more likely to attract attention from 

the children. Besides, as the children are interested in reading, language development can also be 

enhanced. The author also encourages children to play and learn. Playing is also one of the study 

methods, it is an essential part of children’s development (Hinske et al., 2008). Hence, the reading 

process will become more attractive and interesting by integrating interactive activities such as 

augmented reality during the story-telling.  
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1.2 Project Scope 

The scope of this project covers the integration of augmented reality (AR) technology in a learning-

based mobile application in helping the target audience to gain more interaction, engagement, 

provides immersive experience towards learning using AR and to cultivate reading habits from 

youth. The intention of propose this application is to improve or best to solve the cons of traditional 

classroom which is lack of interaction between teacher, adding extra fun towards learning, 

motivation and engagement for target user during study. 

Throughout the planning, an interactive mobile-based augmented reality storybook application 

will be designed and developed in this project. This application is an Android-based application 

so its deployment limited to the Android user. The target audience for this mobile application is 

from preliminary school and primary school students between the ages of 2 to 7. Other than that, 

this application requires support from the teacher and parental supervision. An alert message will 

be generated while every time launched the application to aware user to stay aware of their 

surroundings. Moreover, English will be used as the application’s default transmission language.  

The output of this project aims to benefit in terms of successfully cultivating reading habits among 

the target audience by carrying out interesting content of learning material. The application of AR 

technology enables the target users to visualize the animation and flow of the story by scanning 

the marker of the storybook. The contents of the application are going to integrate the elements of 

multimedia such as text, audio, animation, and image to gain better attention from the target 

audience and provide a better learning environment. Meanwhile, the models of the 3D object and 

animation in the proposed system will be designed based on the flow of the story. A guide of the 

proposed application will be provided for the target audience, parents and teachers to fully 

understand how the application works. 

  



5 
BIS (Hons) Information Systems Engineering 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 

 

Chapter 1 Introduction 

1.3 Project Objectives 

The main objectives of this research project are: 

1. To develop a mobile storybook application with augmented reality technology 

contains different visual representation compare to an ordinary storybook.  

As the problem statement mentioned above, loss of engagement in the study is mainly caused 

by uninteresting teaching material and methods. An interactive mobile augmented reality 

storybook application for early childhood education provides interesting elements and enhance 

their engagement in studies to improve reading skills, language development. The impact of 

different visual representations provided by AR could turn an ordinary storybook to be more 

interesting and livelier for children to attract their attention with a 3D animated model and 

sound. 

2. To identify the reading habits among early-childhood students. 

Lack of Reading habits affects the interest in studies after children grow up. To find out the 

reason why the student does not interest in reading, a questionnaire will be designed and 

distributed to analyse the reasons. 

3. To propose a learning application that contains interaction between user and 

enhancing knowledge transfer. 

Lack of interaction in traditional class room is another critical issue for children to gain 

knowledge effectively. As state in problem statement, students often listen and learn according 

to the teacher’s talk which resulting student become passive learner. An interactive mobile 

augmented storybook not only can transform the boring learning content into an engaging 

learning experience but also create interest and improve the attractiveness among students. 

Interaction is also an essential element required in the application; therefore, children's 

involvement will be more than usual compared to traditional learning method. 
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4. To improve enjoyment during study by learning though augmented reality 

technology. 

Lack of enjoyment during studies is a crucial problem faced in the education field from past to 

present and it was a factor examined in this study. AR technology provides immersive 

experience towards target audience and could easily grab the attention of the kids without been 

easily distracted. Besides, AR represents an innovative way of study for the kids in their early 

childhood education. AR is easier to use and more inspirational compare to traditional learning 

activities.  
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1.4 Impact, Significance and Contribution  

The first problem of this project is the loss of engagement towards studies. This interactive mobile 

augmented reality storybook application can raise the engagement of students through attractive 

multimedia elements. The second problem is a loss of reading habits in youth, this application will 

encourage the student to read the books innovatively. This is to help them to play and learn the 

vocabulary while they participate in the story and make the ordinary storybook looks more 

attractive. The third problem is students are lack of interactive in learning. This application will 

provide interaction that comes with the story to play with and learn. The last problem is the lack 

of enjoyment during learning. This application provides mini-games related to story and 

vocabulary for the target audience to play with it. 

This project will improve the interest and motivation of children to enhance language development 

in an effective way. Developing an interactive mobile augmented reality storybook for learning 

English and cultivate reading habits is not to replace the traditional teaching-learning process in 

the classroom, but to aid the student and learner’s learning experiences. According to (Shabiralyani 

et al. (2015)), visual aids such as sensory objects or images that can initiate or support learning 

better. It can also be used to make the learning process more real, more active and more accurate. 

By using the application, it can help children to learn effectively and in terms of understanding the 

content of the study materials. Augmented Reality contains multimedia elements such as sound, 

image, and animation that are included in the system. Moreover, the most important element is the 

participation required by the children. From a children's perspective of view, these elements can 

attract their attention better and they might be more interested in learning rather than learning 

through a book in words. Words can explain everything but visual elements help to improve their 

understanding.  
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1.5 Background Information 

The main focus of this project is using augmented reality technology to develop an interactive 

mobile-based augmented reality storybook application for early childhood education. Storybook 

is one kind of learning materials for the student to learn and develop language skills. Augmented 

reality technology can be a potential teaching material in the form of education. Children nowadays 

are easily distracted by their surrounding environment. The advance in technology also affects the 

children during the learning process. Children often feel that learning is boring and uninteresting 

compared to watching YouTube and playing games. Loss of interest and attention in the learning 

process will affect the student’s perspective towards learning which also resulting in poor 

performance in school. Some studies also found out students might feel anxiety and refuse to learn 

because of loss of attention in class resulting in poor performance in school (Von Der Embse, 

Barterian & Segool,2013). 

To encourage those kids who are easily distracted, loss of interest and attention from their study 

towards learning, a mobile-based learning application that implemented AR technology helps to 

increase the curiosity of children towards learning and reading innovatively. Certain studies 

conducted by researchers found that the traditional teaching methods in the existing education 

system are defects and flawed (Von Der Embse, Barterian & Segool,2013), (Fahiminezhad et al., 

2012)). One of the limitations in the traditional teaching method is failing in knowledge transfer 

and the transfer power from the teacher to students because of the one-way communication 

teaching method (Fahiminezhad et al., 2012). Due to the problem of using the traditional method 

for teaching and learning languages, there are getting more learning-based mobile applications 

have been proposed to overcome the challenges encountered in language learning. Last by not 

least using the AR system and environment for learning is not replacing the traditional classroom 

activities but it is an additional aided learning tool to enhance the students learning experience. 

The outcome of this project by utilizing AR will have a better performance compared to other 2D 

learning applications which is able to grab the children’s attention and motivate them during the 

learning process. This project outcome provides material of learning for kids which are more 

interactive, attractive compared to the contents of physical books and textbooks. Meanwhile, this 

proposed application requires teacher and parental guidance to use. 
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1.6 Report Organization 

The content of this report divides into seven different chapters. Each chapter will discuss on 

different contents in detailed, this session will briefly describe the contents in every chapters. 

The first chapter will be containing the introduction of the proposed project background 

information, problem statement, problem objectives, project scopes, motivation, impact, 

significance and contribution to create this entire project. 

The second chapter will be containing literature review regarding Augmented Reality technology 

and Augmented Reality technology in education sector. Moreover, three similar application that 

fits the project scopes will be reviewed by the author and compare between the proposed 

application. A table of Comparison will be created to have a clear view of what is the different 

between each other. Other than that, a set of questionnaires will be distribute towards participant 

and analysis on the collected data. 

The third chapter will be containing the rough system design or blueprint to create this the proposed 

application. Methodology, development tools including software and hardware, user hardware and 

software requirement, system design in system flowchart diagram, use case diagram and also the 

application’s storyboard design will be discussed in this chapter. 

The fourth chapter will be containing the preliminary work did in previous final year project 

session. 

The fifth chapter will be containing the system development process and implementation and also 

the guidance to recreate this application in scratch. Setup in Unity3D, download Vuforia database, 

extract image target and audio narration, tool used, 3D model design, animation design and AR 

scene design, user interface design, mini games design and also splash screen design will cover in 

this chapter. 

The sixth chapter will be containing evaluation of the created application which including system 

testing and evaluation of project objectives. 

The final chapter will be containing the conclusion which includes project review, implement 

issues and challenges, discussion of proposed project and also improvement in future works.  
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2.1 Literature Review 

2.1.1 Augmented Reality (AR) Technology 

In this 21st century, the growth of technology is developing at a rapid stride that has dramatically 

affected education and Mobile Augmented Reality (AR) technology is one of the new technologies 

that implement in education. AR is a technology that using the existing environment and overlay 

the virtual things on top of the real environment. The visualize object or graphics could be designed 

in a 2D or 3D model and it is interactable with the user.  

2.1.2 Augmented Reality (AR) Technology in Education Field 

Augmented reality in education brings elasticity and flexibility among the learner as the learner 

can observe how the contents look like. According to research indicated by El Syed, Zayed & 

Sharawy in the year 2010, AR systems and the environment could help learners to develop skills 

and knowledge in the technology-enhanced environment in an effective way. Other than that, AR 

systems and the environment with interactivity needed could also help learners to increase their 

interest in learning (Yen, Tsai, & Wu, 2013). Several researchers also indicated that children 

enjoying story activities that include 3D graphic and interactive sound (Fridin, 2014). Moreover, 

AR teaching material is a good alternative to a conventional picture book and physical interactions 

(Hung, Chen & Huang, 2016). Research has shown positive effects that AR could bring to 

education such as they have a better academic performance. (Bressler & Bodzin, 2013; Yilmaz, 

2016).  

Several researchers have developed many kinds of AR picture and storybooks for educational 

purpose (Behzadan & Kamat,2013; Cheng & Tsai, 2014; Cheng & Tsai,2016). The researcher 

states that the AR storybook provides an attractive learning experience towards children (Dünser 

& Hornecker, 2007). As a result, we can know that the AR-based learning application can provide 

effective learning if there is a proper interaction that takes place. However, there are also some 

negative effects on children if they spend too much time on digital technology. Studies also show 

that spending too much time on digital technology will also affect the poor academic performance 

and to be unhealthy (Park, Kang, & Kim, 2014). Finally, time spending and management on digital 

technology should be maintained appropriately although there are lots of beneficial digital 

technology for students to use. 
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2.2 Critical Remark of Previous Work 

2.2.1 The Beautiful Butterfly 

The Beautiful Butterfly is a smartphone learning-based mobile application developed by Pelangi 

Books which founded in the year 1979. This application is implementing augmented reality 

technology to the storybook for young children who are just beginning to explore the wonders of 

their world through pictures and words. This application is a fully market-based system, users are 

required to use their pictures as a marker provided to see the content of the story. The application 

contains 16 markers to fully explain the story. Other than that, the application provides a simple 

guide for the users to manipulate and rotate the 3D graphics. The application also provides modules 

and features on explaining the habitats of the insects related to the story. Lastly, the graphical user 

interface for the users is simple and easy to use.  

 

Figure 2.2.1.1: Main Menu of The Beautiful Butterfly Application 
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Figure 2.2.1.2: Guide for Manipulate Model in Application 

 

Figure 2.2.1.3: Marker for AR in Application 
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Figure 2.2.1.4: Actual Outcome of Main Function 

 

Figure 2.2.1.5: Safety Warning in Application  
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2.2.2 Strength 

One of the main strengths of this application is that the graphical user interface (GUI) is simple 

and easy to use. Other than that, the interface designed colourfully with special effects can help 

them capture the children’s attention. Moreover, a simple guide is provided for users on how to 

manipulate the models. 2D animation features also provided for the user to watch the full story 

instead of using augmented technology. Narration in this application is provided when the cameras 

successfully capture the marker. Before turning on the in-app camera, a notice will pop up in the 

application that reminds of parental and teacher supervision is needed. This notification also 

reminds users to aware of their surroundings. Lastly, this application is free of charge. 

2.2.3 Weaknesses and Limitations 

The physical book of the story is absence, the users might prefer using physical book with AR to 

see the contents. Other than that, the animation model is created in 2.5D, therefore it is less 

attraction compare to 3D models. The absence of the subtitle or caption provided is another 

limitation of this application. In this case, children might not understand the tone of the narrator 

or miss several words resulting in unable to understand the content of the story. Lack of modules 

such as quiz for the target audience to ensure they are understood the content of the story or the 

exact meaning of some words. Lastly, this application does not support interaction when the user 

clicks on the models. 

2.2.4 Suggestion 

The interaction between user and the 3D model can be considered to added in order to attract the 

user attention and participate in the storytelling process. Module such as quiz and mini-games can 

be implement in the application to test the understanding of the user in this story. Instead of using 

2.5D model, it is better to create a 3D animation model for the story. 3D model can be more 

attractive compare to 2.5D models. Since this application does not require a physical book to 

perform AR activity, the subtitle or words should be adding in the application to shows the accurate 

content of the story otherwise user might misunderstand the content.   
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2.2.2 Toy Story 

Toy Story is a famous 3D animation created by Pixar Animation Studios which acquisition by 

Disney. Toy Story movie was first to come out in the year 1995, 4 movies are being developed in 

this series and the development is still proceeding. This application provides fascinating interactive 

3D models with the implementation of Augmented Reality technology. This application is a fully 

marker-based application that required the users to have their storybook to fully utilize the 

application. Therefore, it is different compared to The Beautiful Butterfly application, Toy Story 

does not provide users the marker in the application. This application contains many interactive 

elements for the users to manipulate with it. For example, once the user clicks on the 3D model, 

different posture will be shown to user. 

 

Figure 2.2.2.1: Main interface of Toy Story 

 

 

 

 

 



16 
BIS (Hons) Information Systems Engineering 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 

 

Chapter 2: Literature Review 

 

Figure 2.2.2.2: Different action is done while clicking the 3D model 

 

Figure 2.2.2.3: Interactive Game in Application [1] 
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Figure 2.2.2.4: Interactive Game in Application [2] 

 

Figure 2.2.2.5: Guideline for User to Manipulate the Application  
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The strength of this application contains fascinating well-designed 3D models that able to grab the 

attention of the users. This application also contains several different interactive game elements to 

play with it. Other than that, this application is also free of charge except for the physical book.  

2.2.3 Weaknesses 

First of all, the main interface of the application is too simple to capture the children's first 

impressions. This application does not provide safety alert or warning towards the users. Other 

than that, the narration in this application is absence. Although it provides a fascinating 3D model 

and interactive games for the users, however, it does not provide the flow of the story. In the 

physical book, it does provide the storyline of each character, however, this application seems 

mainly to focus on previewing each character’s model in the story only. 

2.2.4 Suggestion 

Interface of this application could be designed to be more attractive, for example background can 

be in the scene of story and with others 3D model instead of just “Woody” itself. The application 

could provide a safety notice for user that informing them to aware of the surroundings. The most 

important part is that this application does not shows the full story of the books in AR. Hence, 

narration also without in this application. Developer can consider to develop a storyline in AR for 

the characters. 
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2.2.3 Story World Augmented Reality 

Story World Augmented Reality is developed by Anwarissa Asbah and published by Sawsan Tech 

Sawsan (Tech, 2019). The story world is an application for children that integrates the new 

augmented reality technology with the narration of the stories. It is designed to inherit the old 

cultural stories to new generations entertainingly and interactively (Sawsan Tech, 2019). This 

application is also marker-based. In this application, several features had provided by the developer. 

For example, an in-app puzzle of the stories, guidelines for the users to use the application, and 

narration for the story is provided. Other than that, this application is also free to charge but it is 

also required to buy the physical book to fully utilize this application. 

 

 

Figure 2.2.3.1: Main interface of Story World AR 
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Figure 2.2.3.2: Actual Outcome of the Main Function  

 

Figure 2.2.3.3: Additional Interactive module in Application (Puzzles) 
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Figure 2.2.3.4: Puzzle Game in Application 

 

Figure 2.2.3.5: Guideline for Users to use the Application 
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2.3.3 Strength 

The main interface of this story is designed colourfully which gives a better impression. This 

application provides a guideline for the user to manipulate with their application. The main 

function of this application provides the complete flow of the story by using AR. Narration is 

provided while the in-app camera captures the marker on the physical book. The puzzle game is 

provided in this application, the user can unlock the puzzle stage by stage. The application is 

providing a feedback section, which enables the user to ask a question and collect their feedback. 

Finally, the application is free of charge. 

2.3.3 Weaknesses 

The weaknesses in this application are that the safety alert or notice is absence, this might cause 

children who are not aware of the surroundings. Interactivity during the storytelling is also absent 

in this application.  

2.3.4 Suggestion 

Safety notice can be considered to add in the application that aware of user’s surroundings. This 

application does not provide interaction while user using the application. Developers should 

consider to add interaction with it to attract user’s attention.  
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2.3 Table of Comparison Between Reviewed System and Proposed System 

 

Features The Beautiful 

Butterfly 

Toy Story Story World AR Proposed System 

Platform Android, IOS Android, IOS IOS Android 

Interaction needed 

while storytelling 

   

(no story telling 

in this 

application) 

  

Mini Games 

(Puzzle) 

    

Subtitles     

Safety Alert or 

Notice 

    

User Guideline for 

Application 

    

3D Augmented 

Reality Model 

    

Complete Flow of 

the Story 

    

Narration for 

Storytelling 

    

Required Physical 

Book to Utilize 

Application 

    

Free of Charge 

Application 

    

Table 2.3.1: Table of Comparison 
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2.4 Data Collection 

Data collection is a method to gather user requirements and information needed for development 

to prove the problem statement and come out with solutions or improvements. For this project, a 

survey questionnaire through Google Form is selected as a tool to collect data and information. 

The survey questionnaire is mainly close-ended questions for the participator. A researcher has 

pointed out that the questionnaire is an effective way to collect data (Brace, 2018). According to 

(Brace, 2018) survey questionnaires easily to check for reliability because each of the 

questionnaires is set in standardized form by the individuals who are collecting the data, the same 

question and the same order. Google Form provided convenience to the data collector since it 

provides real-time auto-generates the pie chart after the participator submits the survey. 

           The survey questionnaire contains 16 questions and 50 respondents answered the survey 

question. The purpose of creating these survey questionnaires is mainly to identify the needs of 

this application. Several important questions and data submitted by the respondent will be further 

analysed.  
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Figure 2.4.1: Question 1 of Survey Questionnaire 

Figure 2.4.1 shows that the number of the respondents and their gender in this survey. 

 

Figure 2.4.2: Question 2 of Survey Questionnaire 

Figure 2.4.2 shows that the age group of the participant. The participants are from different age 

group to give provide a feedback on their perspective towards AR in early childhood education. 
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Figure 2.4.3: Question 3 of Survey Questionnaire 

Figure 2.4.3 shows that 76% of the respondents agrees that AR is suitable to implement in early 

childhood education, whereas 24% of respondent disagree with it. From the graph, we can see that 

AR in early-childhood education are mostly accepted by the respondent. 

 

Figure 2.4.4: Question 4 of Survey Questionnaire 

Figure 2.4.4 shows that 54% of the respondents agrees that children should cultivate reading habits 

in youth. 22% of the respondent disagrees and 24% of respondents are remain neutral.  
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Figure 2.4.5: Question 5 of Survey Questionnaire 

Figure 2.4.5 shows that that 80% of the respondents agrees that children who spending too much 

time on digital technology will have some negative effects. However, 20% of respondents does 

not agrees. 

 

Figure 2.4.6: Question 3 of Survey Questionnaire 

Figure 2.4.6 shows that 66% of the respondent feels that traditional classroom that using one-way 

communication teaching method is a lack of interaction between student and teacher. 
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Figure 2.4.7: Question 3 of Survey Questionnaire 

Figure 2.4.7 shows that 72% of the respondents agrees that play and learn method is more suitable 

for children in learning process. 28% of respondents disagrees with that.  

 

Figure 2.4.8: Question 8 of Survey Questionnaire 

Figure 2.4.8 shows that 58% of the respondents agrees that the 5-multimedia element which is 

video, audio, text, animation and images can grab more attention from the children. 18% of 

respondent disagree with it and 24% of respondent remains neutral. 
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Figure 2.4.9: Question 9 of Survey Questionnaire 

Figure 2.4.9 shows that the rating 1 to 5 which indicates 1(very dislike) to 5 (Very Like). In this 

bar chart, the respondents show their perspective on AR implementation in education. 2% of the 

respondent are very dislike, 16% of respondent dislike and 30% of the respondents remains neutral, 

40% of the respondents likes it and 10% of respondents love it. 

 

Figure 2.4.10: Question 10 of Survey Questionnaire 

Figure 2.4.10 shows that the respondent perspective on how children will feel about AR implement 

in education. In total of 60% of the respondent felt that the children might be interested in AR 

learning. 
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Figure 2.4.11: Question 11 of Survey Questionnaire 

Figure 2.4.11 shows that 70% of the respondent felt that AR in education can make a positive 

difference to the children’s reading habits and skills. However, 14% of the respondents does not 

agree with it and 16% of the respondent remains neutral. 

 

Figure 2.4.12: Question 12 of Survey Questionnaire 

Figure 2.4.12 shows that 64% of the respondents felt that implementation of AR will encourage 

children to read more. 20% of the respondents does not agree with it and 16% of the respondents 

remains neutral. 
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Figure 2.4.13: Question 13 of Survey Questionnaire 

Figure 2.4.13 shows that 76% of the respondents agrees that AR can make a deep and lasting 

impression on the children when reading. However, 16% of respondents does not agree and 8% of 

respondents remains neutral. 

 

Figure 2.4.14: Question 14 of Survey Questionnaire 

Figure 2.4.14 shows that 80% of respondents felt that children will probably like AR storybook 

compared to traditional storybook. However, 20 % of the respondents disagree with that and felt 

that traditional storybook is better. 
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Figure 2.4.15: Question 15 of Survey Questionnaire 

Figure 2.4.15 shows that the respondent’s perspective on what might benefit children when they 

using AR storybook. 70% of the respondents felt that AR storybook able to enhance children’s 

language development and 60% of respondent felt that, it is able to raise motivation towards 

Readings. 54% of the respondents felt that children will get a better academic performance. 2% of 

respondent felt that the children can be more critical thinking. 6% of respondent disagree all of 

that and felt AR does not benefit children. 
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Figure 2.4.16: Question 16 of Survey Questionnaire 

Figure 2.4.16 shows that 86% of respondents would download similar AR storybook for children 

to play with if they were parents. However, 18% of the respondents would not try to use AR 

storybook to learning for their children. 

2.4.2 Conclusion of Analysis 

Based on the survey questionnaire data the author collected, the author achieved the additional 

prove to problem statement in section 1.1. which traditional classrooms with using a one-way 

communication method are a lack of interaction between student and teacher, multimedia elements 

could grab more attention from children and solving the problems that children are easy to get 

distracted by the surrounding environment. Other than that, cultivate reading habit from youth is 

important. Therefore, AR Storybook can enhance children's language development, raise 

motivation towards reading. Play and learn are more suitable for children, therefore an interactive 

AR storybook could become suitable learning material for children.  
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3.1  Overview 

In this chapter, the author is going to discuss the system design, methodologies and procedures to 

develop the application in each phase. Furthermore, the author is using the Agile software 

development approach to create the application. The justification for choosing this approach for 

application development includes user involvement, time constraint, and project size. Agile 

software development usually involves 6 major phases of the process which are planning, analysis, 

design, implementation, testing, and maintenance. The following contents will show the detailed 

version of this chapter. 

3.2  Methodologies and General Work Procedures 

For the overall development process, the most suitable methodology applying for this project is 

the concept of Agile software development. Thus, the justification of choosing this approach is a 

process that able to produces software with quality guarantee and lowest cost which is affordable 

by the author. Besides that, time management is also essential and important element for this 

project.  

By using this methodology, the developers are able to saves a great amount of time but with the 

task quality guaranteed because of fast development and testing (Balaji, 2012). This methodology 

ensures that the author’s time management in an efficient way and ensures the whole phase of 

development is going with systematic to develop the proposed application that expected. Moreover, 

this methodology is capable of accommodating new changes, expectancy or enhancement occurs 

during the development phase without the budget constraint. Another benefit of this methodology 

is very flexible that the author can quicky generate some alternative plan to deal with uncertainties. 

Lastly, the small project size of the proposed system does fit the requirement of the agile software 

development which able to maximize efficiency while developing the proposed system. 
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Figure 3.2.1: Agile Software Development Phases 

 

 

 

First Phase: Planning  

In the planning stage, the initial proposal is evaluated to express the problem statement, determine 

the project scope and come out with the project objectives. Furthermore, project timeline planning 

is important for the author to achieve well time management to carry out the proposed application 

on time. Moreover, in this stage also determined the software tools such as Unity3D to be a main 

software application to develop the application, Vuforia SDK to import AR tools and element in 

order to create a AR scene in Unity3D, and Visual Studio 2017 to generate C# script. Other than 

that, methods to collect reliable data for further analysis such as google form, 3D Model designing 

engines such as blender version 2.82, suitable programming language such as C# to use and 

hardware needed in order develop the proposed application. 

  



36 
BIS (Hons) Information Systems Engineering 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 

 

Chapter 3: System Design 

Second Phase: Requirement Analysis 

In the analysis phase, a literature review is to be done on the existing similar application that fits 

the project scope. In the process of reviewing a similar application, their strengths and weaknesses 

will be recorded for analysis afterward. After analysing, a table of comparison which comparing 

the similar application and proposed application is generated by the author. Other than reviewing 

the existing application, the survey questionnaire will be designed through google form and 

distributed towards the target audience by the author to do further analysing on user requirement. 

The user feedback collected from the target audience should enable the author to understand the 

user requirement and inventive idea to design the proposed application. 

Third Phase: Design 

In the design phase, the required material such as software tools, development tools, hardware and 

the feedback collected from the target audience are gathered by the author to proceed to the system 

design. The system design will be more towards to satisfy the user’s requirement that collected 

from the requirement phase. The blueprint of the system design will be carried out by the user. 

Other than that, the UML diagram and the flow of the application is created by the author to show 

the detailed way of each module in the proposed system.  

Forth Phase: Prototyping 

After the design stage, the following is the prototyping stage where the development of the 

prototype will begin. The function of the module specified will be developed and evaluated 

according to the user requirement and feedback. In the first iteration, the initial prototype is 

developed and allows the user to provide their feedback for the proposed application. The initial 

prototype is expected to consist of a vital component, such as the 3D model of the characters is 

created and virtually projected in an AR approach via marker-based surface. 
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Fifth Phase: Improvement in Upcoming Iteration 

After the initial prototyping is created and tested by the user, the feedback collected from the user 

will take into consideration by the author to modify or improve the version tested by the user. This 

process will undergo several times to collect more useful user feedback for any possible system 

modification such as improvement of 3D model design, interface design, and improvised controls.  

Sixth Phase: Implementation 

Toward the end of the testing and development timeline, the proposed project’s intended function 

which is to provide an interactive augmented reality storybook with the 3D model should be 

achieved for the target audience. Once the proposed application is determined to be error-free and 

receives satisfaction from the user, the latest prototype will be published and deliver to the target 

audience. At this point, the user who used the application and their feedback is collected for further 

updates and maintenance. 
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3.3 Development Tools 

3.3.1 Software Development Tools 

The following table shows the software tools and description of each function that used to develop 

the proposed application. 

Software Description 

 

 

Unity 3D is a cross-platform development 

engine which is also compatible with Android 

Studio. Unity 3D is mainly used to develop the 

augmented reality view of the story, importing 

the 3D model that created in blender and merge 

them in to a complete AR scene. 

 

 

Vuforia is a free-source software development 

kit compatible with Unity 3D engine. Vuforia 

is used for the augmented reality features in 

tracking the marker and displaying 3D model 

on top of it. 

 

Blender is a 3D model drawing platform offers 

to developer to draw their own 3D model. 

Flexible for developer to add rig, animation 

into their 3D models. 

 

 

Visual Studio 2017 is an integrated and 

flexible development tools for developers. 

Visual Studio 2017 is used by the author to 

generate C# script for game development. 

 

 

Shotcut Video Editor provides many features 

to edit video and audio, it is simple to use and 

user friendly for beginner. 

Table 3.3.1.1: Software Tools for Development 
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3.3.2 Hardware Development Tools 

 

The following table shows the hardware tools specification that used to develop the proposed 

application. 

1. Computer Model: MSI - GE75 Raider 8RE 

System Information 

Operating system Windows 10 Home 

Processor Intel® Core™ i7-8750H 

Graphic Card Nvidia GeForce® GTX 1060 

CPU 2.20 GHz 

Memory (Ram) 16.00GB 

System Type 64-bit operating system, x64-based processor 

Table 3.3.2.1: Hardware Tools for Development 

2. Mobile Phone Model: Samsung Galaxy S8 Plus 

System Information 

Operating system Android 

Android version 9.0 Pie 

Resolution 1440 x 2960 pixels, 18.5.9 ratio 

CPU Octa-core (4x2.3 GHz Mongoose M2 & 4 x 1.7 

GHz Cortex-A53) - EMEA 

Internal Storage 64 GB 

Memory (Ram) 4 GB 

 

Table 3.3.2.2: Hardware Tools for Development  
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3.4 User Requirement 

3.4.1 User Hardware Specification Requirement 

Description Basic Requirement 

CPU 2.0GHz or higher 

Internal Storage 2GB 

Memory (RAM) 2GB or higher 

Front Camera 5MP or higher 

Table 3.4.1.1: User Hardware Specification Requirement 

Table 3.4.1.1 shows that the minimum requirement of user’s hardware specification in order to 

launch the proposed application without problem or error. In order to provides a better user 

experience, it is recommended user has hardware with 2.0 Giga Hertz, 2GB internal storage, 2GB 

of memory and front camera has a 5 Mega Pixel or higher. 

3.4.2 User Software Requirement 

Description Basic Requirement 

Android Version Android 6.0 or higher 

Table 3.4.2.1: User Software Requirement 

Table 3.4.2.1 shows that the minimum requirement of user software requirement. This application 

is purposely made for Android system; therefore, it is unfortunately that this application is not able 

to support IOS system.  
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3.5 System Design 

3.5.1 System Flowchart Diagram 

 

 

Figure 3.5.1.1 Full System Flowchart (Part 1) 
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Figure 3.5.1.1 Full System Flowchart (Part 2) 
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Figure 3.5.1.2: Augmented Reality function Flowchart in Detailed Version  
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3.5.2 Use Case Diagram 

 

Figure 3.5.2.1: System Use Case Diagram   
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3.5.3 Storyboard Design 

No. of Storyboard : 1 

Title of Project : Interactive Augmented Reality Storybook for Early Childhood Education 

Page Name : Alert 

Internal Link Page : Main Menu 

 

 

Figure 3.5.3.1: Alert Page of Application 

Label Type Description 

T1 Text A big “Warning” text to grab user first attention. 

T2 Text Contains advice and reminder for user to stay aware of surroundings 

and better with parental supervision. 

B1 Button An “OK” button to ensure the user read the text and when user 

clicks it will enable user proceed to next interface. 
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No. of Storyboard : 2 

Title of Project : Interactive Augmented Reality Storybook for Early Childhood Education 

Page Name : Main Menu 

Internal Link Page : Alert, Mini Game, AR Camera, About, Exit  

 

 

Figure 3.5.3.2: Main Menu of Application 

Label Type Description 

S1 Background A background for application’s main menu. 

G1 Title Name of the Storybook. 

B1 Button Name “Play”, Link to AR camera interface. 

B2 Button Name “Mini Game”, Link to Mini Game interface. 

B3 Button Name “About”, Pop up About this application information 

B4 Button Name “Exit”, Pop up message and ask whether user wanted to quit. 

B5 Icon Button Audio Icon, when pressed can be mute or unmute background 

music. 



47 
BIS (Hons) Information Systems Engineering 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 

 

Chapter 3: System Design 

No. of Storyboard : 3 

Title of Project : Interactive Augmented Reality Storybook for Early Childhood Education 

Page Name : AR Camera 

Internal Link Page : Main Menu, Guideline 

 

 

Figure 3.5.3.3: AR Camera interface of Application 

Label Type Description 

B1 Icon Button A house icon button, brings user to main menu when clicked 

B2 Icon Button A question mark icon button, shows guideline for user when clicked 

B3 Icon Button A red cross for user when wanted to close the guideline (T1) 

B4 Button Able to do screen capture when clicked. 

T1 Text Guideline for user to use the AR Camera. 

C1 Camera Display objects on device. 
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No. of Storyboard : 4 

Title of Project : Interactive Augmented Reality Storybook for Early Childhood Education 

Page Name : Mini Game selection 

Internal Link Page : Main Menu, Puzzle Game (Easy), Puzzle Game (Hard), Maze Ball Game 

 

 

Figure 3.5.3.4: Mini Game Interface 

Label Type Description 

T1 Text Show the difficulty of Puzzle (Easy) 

T2 Text Show the difficulty of Puzzle (Hard) 

T3 Text Show Maze Ball Game 

G1 Background Background of the Puzzle Section (Easy) 

G2 Background Background of the Puzzle Section (Hard) 

G3 Background Background of the Maze Ball Game  

B1 Button Select Difficulty (Easy) 

B2 Button Select Difficulty (Hard) 

B3 Button Select Maze Ball Game 

B4 Icon Button Alter to Main Menu interface. 
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No. of Storyboard : 5 

Title of Project : Interactive Augmented Reality Storybook for Early Childhood Education 

Page Name : Puzzle 

Internal Link Page : Main Menu 

 

 

Figure 3.5.3.5: AR Camera Interface of Application 

Label Type Description 

B1 Icon Button A house icon button, alter user to main menu when clicked 

A1 Game Puzzle game activity 
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No. of Storyboard : 6 

Title of Project : Interactive Augmented Reality Storybook for Early Childhood Education 

Page Name : About 

Internal Link Page : Main Menu 

 

 

Figure 3.5.3.6: About the Application Information 

Label Type Description 

T1 Text Text that introduce the application to users. 

B1 Icon Button A red cross for user when wanted to close the pop-up text (T1) 

C1 Background Background of the application 



51 
BIS (Hons) Information Systems Engineering 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 

 

Chapter 3: System Design 

No. of Storyboard : 7 

Title of Project : Interactive Augmented Reality Storybook for Early Childhood Education 

Page Name : Exit interface 

Internal Link Page : Main Menu, Quit application 

 

 

Figure 3.5.3.7: Exit Confirmation 

Label Type Description 

B1 Icon Button A Green Tick for user when decided to quit application. 

B2 Icon Button A Red Cross for user when wanted to continue the application. 

C1  Background Background of the application. 

T1 Text Text that enquire the user whether wanted to quit or not. 
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3.6 Timeline of Project 

 

Figure 3.6.1: Timeline of FYP 1  
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Figure 3.6.2: Timeline of FYP 1 
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Figure 3.6.3: Gantt Chart for FYP 1  
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Figure 3.6.4: Timeline of FYP 2 
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Figure 3.6.5: Gantt Chart of FYP 2  
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4.1 Description of Preliminary Work 

 

Figure 4.1.1: Warning Sign to use the Application 

Figure 4.1 shows a warning sign in the application. This sign will firstly come out when the user 

runs the application right after the splash screen. The sign is mainly to remind the user to be careful 

and stay aware of surroundings before using this application. This is very important that the user 

should always look after themselves about their surroundings while using any of AR application. 

Other than that, these signs also advise that the application is required parental supervision. After 

clicking the “OK” button will, therefore, go into the main page of the application.  
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Figure 4.1.2: Main Menu of Proposed System  

Figure 4.2 shows the Main Menu of the application system. The main menu consists of 4 buttons 

which are “PLAY”, “MINI GAMES”, “ABOUT” and “EXIT”. Each button will perform a 

different action which will link into the following page or scene. Other than that, the author is 

including background music in the main menu. The application is using horizontal view to display 

the user interface.
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Figure 4.1.3: Guideline to use the AR camera 

 

Figure 4.4 shows that if the user clicks on the “PLAY” button, the application will open the AR 

camera for the user to scan on the marker. Other than that, on the top left corner of the AR camera 

appears 2 icons. The house button will perform action that link back to the main menu page and 

the other question marks button will perform show the guideline about basic information on how 

to use the AR camera for the user.  
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Figure 4.1.4: 3D model appears on the marker 

Figure 4.4 shows that when the AR camera successfully detects the marker, the 3D model will be 

displayed on the screen. However, the author is currently not finished the scene based on the 

storybook. This part will be carried on to FYP2 to complete the flow of story.

 

Figure 4.1.5: “About the Application” Button 

Figure 4.5 shows that the “About” button information. If the user clicks on the “About” button, 

this message will pop up. 
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Figure 4.1.6: Exit button in the Application 

Figure 4.6 shows that the “Exit” button on the main menu. If the user clicks on the exit button, 

this message will pop up and ask whether the user really wanted to exit.  

 

Figure 4.1.7: Hierarchy of the Main Menu  
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4.2 3D-Model Design 

 

Figure 4.2.1 Creating and designing of the 3D character using Blender 2.82 

 

Figure 4.2.2 Rigging the 3D model using Blender 2.82 

Blender 2.82 is a software to create 3D models and animation for developers. Flexible for 

developer to add rig, animation into their 3D models. This is the 3D model of the story’s main 

character named “Little Red Riding Hood”. After finished the 3D model mapping, the author is 

adding bone into the 3D model in order to generate animation. Furthermore, the author is required 

to create texture for the character.  
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5.1  Marker-Based Target and 3D Models Creation 

5.1.1 Storybook Selection as Marker-Based Target and Audio Extraction 

First of all, before the author proceed to development phase, the marker-based target is the essential 

element of this project. The author had selected a storybook which is “Little Red Riding Hood” 

publish by Award Publication Ltd. The justification of selecting this storybook is that the target 

audience of this application is student who is in early childhood education and aged can be specify 

at two to seven years old. Other than that, the content of the story is suitable to the target audience 

to read and it can help children encourage and develop reading skills and confidence. 

 

Figure 5.1.1.1 Image of Selected Storybook for Proposed Application 

Figure 5.1 shows that the front page and last page of the storybook. The storybook contains 22 

pages and inside it contains 10 pages of pictures which can be set as the marker-based target for 

the application. The author will turn these 10 pages of pictures into 10 Augmented reality scenes 

by using Unity3D game engine.  
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Figure 5.1.1.2 Main Interface of Any Audio Converter Software 

Other than that, this storybook provides a CD that contains the audio of narration but it is in .cda 

format. As an information, .cda format can only run when the CD is attached in the CD-Room. 

However, the author’s laptop does not have an CD-Room therefore the author converted the .cda 

file format to MP3 file format using the software “Any Audio Converter”. This software is very 

user friendly and simple to use, just drag the audio file into it and select the output file to download. 

The figure 5.2 shows the main interface of the software. 
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5.1.2 3D Model Construction 

The author is using Blender Ver.2.82a to construct the 3D model. Blender is a flexible and had 

numerous of fantastic features to make your 3D model become more realistic, beautiful and others. 

However, this software is not very user-friendly for beginners. The author spends many weeks to 

get used to it. Hopefully, there is many online tutorials to guide the author. 

 

Figure 5.1.2.1 Main Menu of Blender Software 



66 
BIS (Hons) Information Systems Engineering 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 

 

Chapter 5: System Development and Implementation 

 

Figure 5.1.2.2 Modelling using Blender Software 

Figure 5.1.2.2 shows the model that modelling using blender software. It is a wolf and also one of 

the characters in the story. The model is designed at a T-shape of posture because it is easy for rig 

the model. After finish the modelling, 3D model can be also do texturing in blender. After that, 

the author will add bones into it, this action makes the 3D model able to move which can later 

become an animation. The author will only show one of the 3D models in this report. The detailed 

way to construct a proper 3D model can be found at online tutorial.  
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5.2 Unity3D Game Engine and Vuforia SDK Setup 

5.2.1 Unity3D 

The author’s Unity is in version 2018.4.11f1, please note that any different user interface in Unity 

might because of different version of Unity. The proposed application is designed for Android 

system; therefore, it is needed to setup in Unity before starting to do the scene. The author will 

provide a guide on how to setup in Unity3D. 

Firstly, In Unity, opens build setting where you can press CTRL+SHIFT+B or go to File > Build 

Setting to open. Secondly, select Android in Platform and clicks switch platform. Another 

important thing is that, windows operating system is unable to build IOS system, do not try to 

build on IOS. The consequences might be heavy, files can be deleted and unable to recover back. 

 

Figure 5.2.1.1 Unity Platform Setup. 
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5.2.2 Import VuforiaSDK and Plugin into Unity 

In order to build Augmented Reality project by using Unity3D, it is better that using Vuforia SDK 

plugin. Access to https://developer.vuforia.com download the Vuforia SDK from the website. 

After that, go to File > Build Settings > Player Settings > XR Settings and select/tick Vuforia 

Augmented Reality Supported to activate Vuforia Engine. 

 

Figure 5.2.2.1 Activate Vuforia Engine in Unity 

5.2.3  Setup for Player Setting in Unity 

Player Setting is basically configuring the icon Image, Product Name and Company Name of your 

project. First go to File > Build Settings > Player Setting and fill in the information. Example 

below shows that the author configuration. 

 

Figure 5.2.3.1 Player Setting Setup in Unity3D 

  

https://developer.vuforia.com/
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5.3 Vuforia License and Setup Image Target 

5.3.1  Obtain Vuforia License 

Vuforia License is another essential element in order to use the VuforiaSDK in Unity. Firstly, 

create an account in https://developer.vuforia.com if you are first time user, otherwise sign in and 

generate a development license key for the application. In the website, Go to Develop > License 

Manager > and Get Development Key. After successfully generated development key will result 

in the figure below. 

 

Figure 5.3.1.1 Vuforia Engine Developer Portal – Generate License 

Figure 5.3.1.1 shows that the auto generated license key. Next, copy the license key generated by 

the website and follow the following steps and image to paste in Unity3D. 

  

https://developer.vuforia.com/
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5.3.2  Input License Key in Unity3D 

After created the license key, copy the generated license key and paste in Vuforia configuration in 

Unity3D. In Unity, Go to Windows > Vuforia Configuration or CTRL+SHIFT+V and paste the 

copied license key in “App License Key” section. 

 

Figure 5.3.2.1 Vuforia Configuration in Unity3D – Paste App License Key 
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5.3.3  Add Image Target in Vuforia Database 

First, sign in to Https://developer.vuforia.com and click on Develop > Target Manager > Add 

Database. Create a database in Vuforia which used to store the image as the marker-based target.  

 

Figure 5.3.3.1 Vuforia Engine Developer Portal – Create Database 

After created the database, click the database you created and hit “Add Target” where you can 

upload the image you wish to use as marker-based target to do Augmented Reality project.  

 

Figure 5.3.3.2 Vuforia Engine Developer Portal – Add Image Target (1) 

https://developer.vuforia.com/
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When click on Add Target, this interface should come out. It is recommended to upload .PNG 

and .JPG file format. Secondly, it is important that you need to set the “Width” to 1 and type the 

image name. After finished fill in the information, click on “Add” and the image is successfully 

uploaded in Vuforia database. 

 

Figure 5.3.3.3 Vuforia Engine Developer Portal – Add Image Target (2) 
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5.3.4  Download Vuforia Database and Import in Unity 

After finished adding all the image target, download the database from the website and import it 

into Unity3D so that you can use the Image target in Unity.  

 

Figure 5.3.3.4 Vuforia Engine Developer Portal – Download Database 

In Unity, Go to Windows > Vuforia Configuration or CTRL+SHIFT+V, in Database section click 

Add Database to add Database. The Figure 5.3.3.5 shows that the author’s database is successfully 

imported and it is all ready to develop the AR storybook. 

 

Figure 5.3.3.5 Unity3D Game Engine – Add Database 
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5.4  Develop Augmented Reality Storybook with Unity3D 

5.4.1 Alert Message Scene 

Alert Message that aware of user’s surroundings is the most important thing that needed to include 

in this Augmented Reality Application. Therefore, the concept of design this Alert Message is plan 

to located right after the splash screen scene so that the user can always see the message at first. 

 

Figure 5.4.1.1 Output Interface of Alert Message 

Figure 5.4.1.1 shows that the author generated alert scene in Unity3D. The content of this alert 

message will be: 

1. Requires Parental Supervision. 

2. Stay Aware of Surroundings. 
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Figure 5.4.1.2 Adding Image in Unity3D (1) 

To create this scene is simple, Firstly, gather all the images and import it into Unity3D. Secondly, 

go to “Canvas” > UI > Image to add a game object. You can rename it and it is easier to align in 

your scene later. Next, drag the image from project folder and drop it in the “Source Image” tab. 

 

Figure 5.4.1.3 Adding Image in Unity3D (2) 
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Next, create a “OK” button that when click is detected will link to main menu page. Go “Canvas” > 

UI > Button to create a new button. After created a button, you can decorate your button with 

pictures by drag the image to “Source Image” tab.  

 

Figure 5.4.1.4 Adding Button in Unity3D (1) 

 

Figure 5.4.1.4 Adding Button in Unity3D (2) 

Next, a C# script is created in order to lead the user to main menu when click the button. The C# 

script can refer to Figure 5.4.1.5. After created the C# script, drag the script into “On Click ()” tab. 

Follow the setting and the button can be work perfectly. 



77 
BIS (Hons) Information Systems Engineering 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 

 

Chapter 5: System Development and Implementation 

 

Figure 5.4.1.5 MainMenu.cs 

Main Component Function 

Main Camera Display Alert Scene 

Directional Light Create light for the scene 

Canvas Create a button and implemented “MainMenu” 

script in Figure 5.4.1.5 in order to load into 

Main Menu Scene. 

Table 5.4.1.1: Main Components in Alert Scene  
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5.4.2 Main Menu Scene 

This section will guide and describe the functionality and the development process in Main Menu 

Scene. Main Menu Scene is the internal link page for all the modules which are AR storybook and 

Mini Games Scene. Let the author describe the functional in this scene first. 

Figure 5.4.2.1 Main Menu Scene 

Figure 5.4.2.1 shows that the Main Menu of this application. When the author reaches this main 

menu will first plays the background music. If the user clicks on “Play” will then enter AR mode 

which is the AR storybook scene. Other than that, when user click “Mini Games” will lead to 3 

choices of Mini Game which is rotation puzzle with easy and hard difficulties and a maze ball 

game. Next, the “Download” button will lead the user to a website that enable the user to download 

the target marker for this application. “About” button shows the general information of this 

application. Finally, for the “Exit” button will prompt user exit confirmation. 
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Figure 5.4.2.1 About Panel in Main Menu 

 

Figure 5.4.2.2 User Exit Confirmation 
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To create this Main Menu Page is also very simple, it is not much different compare to create Alert 

Message Scene. The main difference is that this scene contains background music. How to do it is 

simple, In Hierarchy > Create > Audio > Audio Source and drag the MP3 format audio into the 

“AudioClip”. You can also adjust the volume, pitch in this section. 

 

Figure 5.4.2.3 Background Music Setup 

In order to make the background music continue to play and stop in specific scene, we will need 

a simple C# script. 

 

Figure 5.4.2.4 BgMusic.cs  
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Other than that, for the “Download” button, we can use the MainMenu.cs script in Figure 5.4.1.5. 

A function called “Download()” can alter the user to the specific website to download the Image 

Target. The user can save all image target into a .PDF file and generate a share link for user to 

download the image target. 

 

Figure 5.4.2.5 Download Button Configuration 

 

Figure 5.4.2.6 Hierarchy of Main Menu Scene 
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Figure 5.4.2.6 shows the structure of the Main Menu scene. The function of the main components 

is stated in detailed in Table 5.4.2.1. 

Main Component Function 

Main Camera Display Main Menu Scene 

Directional Light Provide Light in Scene 

Canvas Implemented MainMenu.cs script in Main 

Menu which used to load scene, exit function, 

interactive click sound. In Canvas also 

included “Play”, “Mini Game”, “Download”, 

“About” and “Exit” Button 

About Panel A panel that show introduction of application 

Exit Panel A panel to prompt user exit confirmation 

BgMusic Implemented BgMusic.cs that plays 

background music. Allows the music to 

continue or stop in specific scene. 

Table 5.4.2.1: Main Component in Main Menu Scene 
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5.4.3 AR Storybook Scene 

5.4.3.1 Part 1 

In this session, the author will show how to create an AR scene, importing 3D models, ways to 

create animation and import narration sound. First of all, AR scene have some different compare 

to original scene. Instead of using default main camera, we would use AR camera from 

VuforiaSDK. Therefore, delete the default main camera and add AR camera. For how to add AR 

camera can refer to Figure below. 

 

Figure 5.4.3.1.1 Create AR Camera from Vuforia Engine 

Next create an Image target inside AR Camera, so that when the camara detected the image target 

it is able to show the scene. In AR Camera > Right Click > Vuforia Engine > Image. 

 

Figure 5.4.3.1.2 Create Image Target from Vuforia Engine 
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After successfully created an image target in AR camera, choose any image that downloaded 

previously from the Vuforia database that you wish to use as a marker-based target. For example, 

the author’s Vuforia Database named “Storybook” and “0_scaled” used for scene 0 which is 

introduction of the storybook content. 

 

Figure 5.4.3.1.3 Select Image Target from Vuforia Database 

Next, rename the Image Target to “Scene1” and drag the 3d Model into it. At this point, you are 

able to display 3D model in Augmented Reality when the camera detected the image target. For 

example, the author has three 3D model inside scene 1 which is kitchen and 2 characters. 

  

Figure 5.4.3.1.4 Add 3D Model to Image Target 
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Before we can configure and use the audio narration file (MP3) to be responsive when the camera 

detected an image target, the MP3 has to be import into Unity3D first. Create a folder, place the 

MP3 file inside, drag and drop the MP3 into your asset folder. 

 

Figure 5.4.3.1.5 Import Audio to Unity3D (1) 
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Next, a C# script is needed as to be the event handler. The function of this C# script is that when 

the camera detected a specific image target, then the specific audio clip will play at that moment. 

This script also contains the function when the camera lost to detect a target, audio and timeline 

asset will be stopped and reset until the marker-based target can be detected again. This script also 

enable the played audio not looping. 

 

Figure 5.4.3.1.6 DefaultTrackableEventHandler.cs (1) 
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Figure 5.4.3.1.7 DefaultTrackableEventHandler.cs (2) 
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Figure 5.4.3.1.8 DefaultTrackableEventHandler.cs (3) 
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Figure 5.4.3.1.9 DefaultTrackableEventHandler.cs (4) 
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Figure 5.4.3.1.10 DefaultTrackableEventHandler.cs (5) 
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Figure 5.4.3.1.11 DefaultTrackableEventHandler.cs (6) 

After complete create this C# script, drag into your Image Target or Scene. You can refer to Figure 

5.4.3.9 to configure the audio name and scene name to match your resource. At this stage, the 

application can be play narration audio when the image target is being detected and stop when the 

image target is lost. 
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5.4.3.2 Part 2 

In this session will cover timeline editing and animation. Before that, some minor configuration in 

3D model is required. Select every humanoid avatar, go to 3D model import setting > Rig > 

Animation type > select Humanoid and click on apply. 

 

Figure 5.4.3.2.1 3D Humanoid Model Configuration 

After finish rigging all 3D humanoid models, then it is good to go and proceed to timeline creation. 

First to create a timeline, Go to Window > Sequencing > Timeline. The timeline bar should appear 

at the bottom of Unity3D. Next, click Add > Animation Track and choose the preferred 3D model 

and drag into the animation track and right click to add the animation from animation clip. 

 

Figure 5.4.3.2.2 Add Animation Clip from Timeline 
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Next, choose the imported animation clip that created using Blender 2.82 or you can import from 

some website such as https://mixamo.com. Adding 2 or more animation clip in a 3D model is 

possible, left click on the animation clip, then it is able to configure the clip transform offset for 

3D models. Other than that, there is another way to do timeline, just merge them together. Go to 

the second animation clip > right click and choose match offset to previous clip. Follow the step 

if contain different and multiple animation clip. Also the speed of the animation clip can also be 

changed in clip timing > Speed Multiplier.  

 

Figure 5.4.3.2.3 Merging Animation Clip 

 

Figure 5.4.3.4.4 Adjust speed Multiplier 

https://mixamo.com/
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Other than using timeline, we can use Unity3D build in animator system to do the animation. To 

do this, you will need to have bones in your 3D models. To add bones into 3D model, you will 

need blender to do that. After adding bones to 3D models, reimport it into Unity3D. Go to Window > 

Animation > Animation. In this section, you can edit the movement of the 3D models frame by 

frame. 

 

Figure 5.4.3.4.5 Animation Editor 

Finally, while in AR mode we can add interaction between the application and the user. The user 

can rotate, zoom-in, zoom-out are one of the interactions can be done. How to do it is easy, go to 

Unity3D Asset Store > search Lean Touch > download and import it into your application. It is a 

free and useful asset, implement it into the application could have improve the user experience 

toward AR Storybook. 

 

Figure 5.4.3.4.6 Unity3D Asset Store. 
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Main component Function 

AR Camera Vuforia Engine AR Camera to stimulate the 

AR scene 

Canvas Includes a hidden Guideline panel with a 

question mark button. A Home button leads 

the user go back to the main interface. 

Main Menu Includes scripts to every button in this page, 

when the user clicks the button will play click 

sound, 

Scene Contains Scene 0 to Scene 10 of the story 

Lean Touch Provide scale and rotate in AR Mode. 

Table 5.4.3.2.1: Main Components in AR Mode  
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5.4.4 Mini Game Scene 

In this section will discuss how to create a simple rotate image puzzle for user. As this application 

is mainly for children so the difficulties should not be too hard. Here is the sample of the puzzle 

Game. 

 

Figure 5.4.4.1 Puzzle Game Example (1) 

 

Figure 5.4.4.2 Puzzle Game Example (2) 
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Figure 5.4.4.3 Puzzle Game Example (3). 

To create this simple puzzle game, simply select one of the images in asset folder and make sure 

change the image format to sprite (2D and UI), then set Sprite Mode to Multiple and Pixels to Per 

Unit to 100. After that, click on Sprite Editor. 

 

Figure 5.4.4.4 Import Setting of the Images. 
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Next, In Slice tab > select Grid by Cell Count to choose your preferred difficulties for the game. 

After that, click Slice. For example, the author choose to slice at 4x3 which will generated 12 

separate parts of this pictures. 

 

Figure 5.4.4.5 Slice Setting in Sprite Editor. 

  



99 
BIS (Hons) Information Systems Engineering 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 

 

Chapter 5: System Development and Implementation 

After slicing the picture, drag all the picture fragments as a game object into scene. Arrange 

accordingly, hold V and connect each picture seamlessly.  

 

Figure 5.4.4.6 Arrange Picture Fragment (1). 

 

Figure 5.4.4.7 Arrange Picture Fragment (2). 
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Next, add all the picture fragment a “BoxCollider2D” component and additionally adding one C# 

script as shown in Figure 5.4.4.8 into the picture fragment. This script enables the picture puzzle 

rotate at a single side. Once all of the pictures are in the correct position and will show win message 

to the user. 

 

Figure 5.4.4.8 GameControl.cs. 
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Next create a game object and rename it as “GameControl”. Drag in the C# script shows in Figure 

5.4.4.9, this script function as when the user clicks on the picture fragment, the picture will rotate 

in 90 degree and stop provide user to rotate when they win the game. 

 

Figure 5.4.4.9 Rotate.cs 

 

Figure 5.4.4.10 Hierarchy of Puzzle Game 
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Main Component Function 

Main Camera Display the Puzzle Game scene 

Canvas Includes a back button that leads user back to 

mini game scene. A winText that appears 

while user win the puzzle game 

menuCtrl Used to make every button responsive and also 

have click sounds. 

Bgmusic Plays background music 

GameControl Includes a script shows in Figure 5.4.4.9 

 

Table 5.4.4.1: Main Component of Mini Game Scene 
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5.4.5 Splash Screen 

Lastly, creating a splash screen in Unity3D is simple. When every time the user launches the 

application, the splash screen will be shown at the first as figure below. The splash screen requires 

two images which is a logo and a background image. To create a splash screen in Unity3D, go to 

File > Build Setting > Player Setting > Splash Image and remember to select Android System, 

drag the images into “Logos” and “Background Image”. Setting the logo duration can makes the 

logo appears longer or shorter time to enter the application. 

 

Figure 5.4.5.1 Splash Screen Demo 
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Figure 5.4.5.2 Splash Screen Configuration 
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5.4.6 Build Completed Application 

Finally, the complete developed application using Unity3D has done. The last step is to build the 

proposed application. First go to File > Build Settings, include all the scene had done in previous 

session and clicks Build and Run. Unity3D will generate an APK file for testing. Import the APK 

file into Android Mobile Device and then it is all set to go. 

 

Figure 5.4.6.1 Build Configuration 
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6.1 System Testing 

The author had installed and tested the proposed application into different model of smart phone 

and android version from 6.0 or higher. The testing phases mainly focuses on the functionality of 

UI buttons, background music, proper 3D model visualization and accurate scene load while 

different marker is detected, mini game modules and audio can work, responsive in different 

devices. 

 

Figure 6.1 AR Scene 1 Testing 

 

Figure 6.1 AR Scene 2 Testing 
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Figure 6.3 AR Scene 3 Testing 

 

Figure 6.1 to Figure 6.3 shows that 3 scenes tested in different mobile device and it is working as 

expected. After testing on different devices, the author concludes that all the function working fine, 

the application is able to be responsive in any screen resolution in android devices.  

6.2 Evaluation of Project Objectives 

According to project objectives stated in Chapter 1, the author had successfully achieved on: 

1. Successfully developed a mobile storybook application intergrade with augmented reality 

technology and to show different visual representation compare to an ordinary storybook.  

2. Successfully identify the reading habits among early-childhood students through analysing 

from the response of questionnaires. 

3. Successfully developed a learning application that contains interaction between user and 

enhancing knowledge transfer towards user. 

4. Successfully improve enjoyment during study by learning though augmented reality 

technology. 
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7.1 Discussion 

Augmented Reality technology trend is nowadays rapid evolution. Through reviewing some of the 

other existing AR storybook application, some of them does not aware and do not have one of the 

most important things which is safety alert message. As we know that AR provides interesting 

contents displays through our mobile devices, which meaning that the person who watching AR 

contents might not aware of their surroundings. These negligence about their surroundings can be 

deadly, any kind of accident might occur especially for children who using their parent’s device 

to play. Therefore, in my opinion, safety alert message and confirming parental guidance for 

children under 12 years old is a must in every mobile AR application. 

Other than that, the time constrain given to complete this task perfectly is difficult, as one weakness 

of this application is that the interactivity that supposed to have more than current version. 

Moreover, some of the other similar system contains built-in camera system. Sadly, the proposed 

system unable to have such features. There are many similar plugins that sells in Unity Asset Store 

however the price range is from 10 to 40 USD which is extreme costly for the author. The author 

tries to implement another methods and tutorials from any internet sources but unfortunately all of 

them failed. Thus, if the user wanted to have a screenshot of the 3D scene, they can only use 

screenshot method from the mobile device. 

However, the strength of the proposed application is it provides interesting 3D models and 

animation that can easily attract to user. Nice and soft background music plays when the user using 

the application. Other than that, the proposed application contains full flow of story with narration. 

By reviewing some of the existing similar application, they either does not have full flow of story 

or not having a true 3D models in their AR scene. Therefore, this can also consider a strength of 

the proposed application. Moreover, the proposed application contains interactivity with users 

which some of the other application does not have this feature. 
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7.2 Implement Issues and Challenges 

The main issue and challenge that the author faced in this project is the author was lacked of 

knowledge and experience in developing the proposed project by using Unity 3D. Since Unity 3D 

has a lot of tools and functions, the author used few weeks for learning the usage of tools and 

functions for developing the proposed system. 

Other than that, difficulty in designing of 3D model and objects is another major challenge faced 

by author. Drawing skills is highly required in order to construct a beautiful model, however the 

author is kind of weak in drawing. Thus, one of the solutions is to search similar 3D model to edit.  

Besides that, although Blender 2.82 software is a flexible and not very user-friendly for beginners, 

it is seeming to be suitable for experiences 3D designer. Solution for this problem could be 

purchasing 3D models which is really hard to draw or seek for some friend who is good in drawing 

skill.  

Moreover, create rig and bones into a constructed 3D model to do animation is also challenging 

and time consuming. This is because that the author needs to set and adjust the animation frame 

by frame so that the 3D model does not appears weird motion. Another thing is that the author 

needs to create a total 5 character and 10 scenes with animation in this story. 

7.3 Future work 

The current version of application is complete on basic requirement, there is many things can be 

improved. The author prepared a list that could possible to improve in future. 

1. Increase interaction while user using AR Mode. The application might can be designed to have 

more interactivity with user. 

2. Improve the 3D model animation to be smoother, therefore it will not seem to be awkward in 

some scene. 

3. Have more Mini-Game to help learning in English in AR. For example, AR word finding game. 

4. Possible to make it a marker-less Augmented Reality application. 

5. Support in different language. 
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7.5 Conclusion 

Augmented Reality technology are currently matured and by utilizing this technology, all the 

imaginary things can come true. As a conclusion for this project, the problem with loss of 

engagement in studies, loss of reading habits in youth, lack of enjoyment during studies can be 

identified. Therefore, the proposed mobile application is intended to solve these problems. These 

problems became strong motivation for the author to develop this project and wish to encourage 

children to cultivate reading since youth. Other than that, the author wishes to provide the students 

to have an interactive and interesting reading experience by implementing multimedia elements 

and augmented reality. Besides, as the children are interested in reading, language development 

can also be enhanced.  

The objectives of this project are to develop an interactive mobile storybook application with 

augmented reality technology contains different visual representations compare to an ordinary 

storybook. Secondly, to analyse the reading habits among students. Lastly to verify the result after 

using the completed proposed application. 

The author also encourages children to play and learn. Playing is also one of the study methods. 

Hence, the reading process will become more attractive and interesting by integrating interactive 

activities such as augmented reality during the story-telling. Developing an interactive mobile 

augmented reality storybook for learning English and cultivate reading habits is not to replace the 

traditional teaching-learning process in the classroom, but to aid the student and learner’s learning 

experiences. 
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4. SELF EVALUATION OF THE PROGRESS 

Need to spend more time on drawing 3D model 

 

 

 

 

       ____________  _____________    _______ _________ 

 Supervisor’s signature            Student’s signature 
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1. WORK DONE 

[Please write the details of the work done in the last fortnight.] 

 Finished construct Little Red Riding Hood 3D models 

 Created 2 basic AR scene in Unity3D 

2. WORK TO BE DONE 

 Learn more on adding rig and bone to animate the 3D model 

 Construct Grandma, hunter, scene background 3D model 

3. PROBLEMS ENCOUNTERED 

 Rigging, creating 3D model animation are so time consuming! 

 

4. SELF EVALUATION OF THE PROGRESS 

Time left no more need to speed up. 
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117 
BIS (Hons) Information Systems Engineering 

Faculty of Information and Communication Technology (Kampar Campus), UTAR 

 

FINAL YEAR PROJECT WEEKLY REPORT 

(Project I / Project II) 

 

Trimester, Year: Jan 2020 Study week no.: 7 

Student Name & ID: KUEK POH SENG 1502865 

Supervisor: MS. SAW SEOW HUI 

Project Title: INTERACTIVE AUGMENTED REALITY STORYBOOK FOR EARLY 

CHILDHOOD EDUCATION 

 

1. WORK DONE 

[Please write the details of the work done in the last fortnight.] 

 Completed simple movement like walk around etc for Little Red Riding Hood and 

Big bad wolf. 

 

2. WORK TO BE DONE 

 Construct Mother, Hunter, scene background 3D model 

 Colouring 3D model, Create following scene. 

 

3. PROBLEMS ENCOUNTERED 

 Hardware problem occurs, laptop hinge broken. Unable to open, hopefully have 

backup in my hard-drive and borrow laptop from my friend. 

 

4. SELF EVALUATION OF THE PROGRESS 
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1. WORK DONE 

[Please write the details of the work done in the last fortnight.] 

 Texturing created 3D models, background and etc. 

 Extract and convert CD file format audio to MP3. 

2. WORK TO BE DONE 

 Need edit the MP3 audio and create C# script, when the marker-based target 

is detected, the audio of the scene plays. 

 Some character animation is not done. 

 

3. PROBLEMS ENCOUNTERED 

 Laptop comeback, but encountering some compatible problem because run 

on other version of unity and blender from my friend’s laptop. 

4. SELF EVALUATION OF THE PROGRESS 

Need to Speed up. 
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1. WORK DONE 

[Please write the details of the work done in the last fortnight.] 

 Somehow created all 3D models, however animation is another thing to headache. 

2. WORK TO BE DONE 

 Need some idea on how can be interactive between users. 

 Try to do the report to become up to date. 

 

3. PROBLEMS ENCOUNTERED 

 Time consuming Animation  

 

 

4. SELF EVALUATION OF THE PROGRESS 
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